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About This Documentation

This documentation applies to version 2021.10 of the Prinect Manager.

Note: Color and form proofers are set up and connected to the Prinect Manager with the 
"Prinect Color Proof Pro" software. Proofers can also be linearized and calibrated with Color 
Proof Pro. See also Prinect Color Proof Pro - Online Help.

This documentation will give you a brief introduction to operation of the Prinect Cockpit. An example 
will also show you how to configure and execute a standard work process for offset printing. As an 
introduction into the digital printing workflow the "Prinect DFE" documentation (as a PDF document) 
is available. See Quick Start Guide – Prinect DFE.

Note: The Prinect Manager represents the Prinect Workflow variant with the highest inte-
gration level. Because this documentation was written not only for the Prinect Integration 
Manager but also for the Prinect Prepress Manager, the Prinect Pressroom Manager, the Pri-
nect Postpress Manager, the Prinect One Box and the Prinect Digital Front End (DFE), the 
general term "Prinect Manager" will be used in this documentation. A specific variant will 
be mentioned explicitly only in special cases.

Note: The names (e.g. job names, customer names, etc.) and quantities or dimensions (e.g. 
delivery quantities, sheet dimensions, paper dimensions, etc.) given in the following docu-
mentation – and in particular those appearing in the screenshots shown – as well as other 
individual designations used are intended as examples to illustrate the functionality of the 
respective settings and processes and should under no circumstances be adopted into 
your configurations or production processes without checking them.

What you should already know

We assume that you are familiar with the Windows® and Mac OS X®operating systems that are sup-
ported by this application. You should also be familiar with the processes and terms used in a digitally 
controlled print shop workflow.

�

�

�

�

�

�

https://onlinehelp.prinect-lounge.com/Prinect_Color_Proof_Pro/Version2021/en_12/#t=Prinect%2FStart%2FStart.htm
https://onlinehelp.prinect-lounge.com/App/App_pdfs/pdfs/DFE_Workflow_2021_en.pdf
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Further Documentation

You can find more information in the following documentation:

• in the "Prinect DFE 2021 Quick Start Guide" manual

• in the Heidelberg Prinect Licensing - User's Guide

• in the Online Help for the Prinect Cockpit

Symbols and Styles

The following typographical conventions are used in this manual:

• References to other chapters and sections are blue (on the screen) and underlined.

Example: See "Symbols and Styles", page 8.

• Quotation marks are used to indicate menus, folders, functions, hardware conditions, switch 
settings, system messages, etc.

Example: Set the switch to "off".

• Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".

• A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is indicated by symbols at the side which are used as follows:

Warning: Contains information that must be taken into consideration to protect the user 
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to 
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can 
be performed.

�

�
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Basic Concept of the Prinect System

The Prinect Manager provides you with all the functionalities for an automated print shop workflow, 
depending on the configuration. This workflow covers preparation of the digital job data (documents, 
images), proofing and CTP output, monitoring of the print process right up to connection to finishing 
of the printed products.

Note: In the following, the term "Prinect Manager" is used as a general identifier for the Pri-
nect Production Manager, the Prinect Integration Manager or the Prinect Digital Front End 
(Prinect DFE).

�

�
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What Components Does a Prinect Manager Workflow Have?

A Prinect Manager is built up on the model of a server-client architecture. The core of the system con-
sists of central components that control all the processes in the system and that regulate communi-
cation flow between the single components. Important basic data such as printing materials, user or 
customer data, color profiles, etc., are stored in the MDS (Master Data Store). Job processing is done 
by "engines".

The user interface of the Prinect Manager is the "Cockpit" that can be installed as a client application 
on several computers (Windows and Mac OS) in the network environment.

How do I use the Prinect Manager?

The "Cockpit" is the central user interface for all work that a user does on the Prinect Manager. The 
Cockpit is installed together with the Prinect Production software on the Prinect Server computer. 
The Cockpit clients can be installed via the Prinect Maintenance Center (PMC) in a Windows and in 
a Mac OS X operating system environment. You can perform the following tasks in the Cockpit:

• Edit basic system settings (create users and customers, enter spot colors and printing material, 
etc.)

• Set up processing steps ("sequences") for job processing,

Prinect Manager 
Server PC

Communication services, 
Master Data Store

Prinect Maintenance Center

Prinect Cockpit Prinect Cockpit

Prinect PDF Toolbox

Additional Cockpit 
Workstation (Windows 
or Mac OS)

Prinect engines, 
Renderer

Prinect PDF Toolbox
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• create jobs, compile job components (input files, sheet layouts), view and monitor jobs, submit 
jobs or job data for processing or for approval, check the job status.

Prerequisite: A licensed copy of the Adobe Acrobat Professional software must also be 
installed on each workstation on which the Prinect Cockpit is used. Acrobat Professional is 
used for various purposes when processing print jobs in the Prinect workflow, e.g. for the 
visual inspection of PDF documents or for using the Acrobat plug-ins "Prinect PDF Toolbox" 
or "Prinect Imposition Editor". Acrobat Professional is not included in the scope of delivery 
of the HEIDELBERG Prinect software. The operator of the Prinect software is responsible for 
ensuring that an Acrobat Professional installation is available on the relevant workstation 
before starting the installation of the Prinect components - which also include the Prinect 
PDF Toolbox.

Note: The Prinect Cockpit is the user interface in which a Prinect Manager is set up and 
managed in all its details. Subtasks such as creating new jobs using preconfigured sequence 
templates or monitoring ongoing production processes can optionally also be carried out in 
the "Prinect Portal" web user interface. The "Plate Pilot", which can be used to put together 
stacks of printing plates, and the "PPF Handler" for configuring the import of jobs from 
third-party PrePress systems are only operated in the "Prinect Portal". Information on this 
can be found in the online help for the Prinect Portal or in the "PPF Handler" chapter of the 
Cockpit Help. You can access the Prinect Portal in the "Tools" menu in the Prinect Cockpit.

How Do I get the Installation Files?

Prerequisite: To install the Prinect Production software, you need the Prinect Maintenance 
Center (PMC). The Prinect Production installation packages can be downloaded in the PMC 
"Product Installations" view.

Warning: In general, it is recommended to contact HEIDELBERG Support for the installation 
of the Prinect Production software, as the installation process is complex and requires spe-
cial knowledge.

If the Prinect Production software is to be initially installed in a system environment in which no other 
Prinect product is installed, there is usually no Prinect Maintenance Center installation in the system 
environment. In this case, you can download the Prinect Maintenance Center installation package 
from the HEIDELBERG homepage in the "Software" menu under "Prinect Software Downloads" and 
install it in your system environment.

See Prinect Software Downloads.

After installing the Prinect Maintenance Center, you must register your company and at least one user 
in the HEIDELBERG customer portal in the PMC user interface and log in to the customer portal. 
Information on this can be found in the Prinect Maintenance Center online help.

�

�

https://www.heidelberg.com/global/en/software/workflow/prinect_updates/prinect_downloads.jsp
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How Does Licensing Work?

Each installation of the Prinect Manager software includes installation of all the software compo-
nents, irrespective of the licenses purchased. The number of options that you can use on a perma-
nent basis is controlled by a license key. The "Prinect Licensing" module controls the enabling of the 
options and administration of the licenses. The Prinect Licensing software consists of two compo-
nents, the License Server and the License Manager. The licenses are enabled online via the HEIDEL-
BERG Trust Service. As of version 2019 licensing via a dongle is no longer supported – with the excep-
tion of a few use cases. The switchover to online licensing is also applicable for any version upgrades.

Online licensing is based on an online protection certificate that is activated during software instal-
lation. Therefore, before installing the Prinect Production software, you must request an installation 
code from the HEIDELBERG licensing department, which you enter at the appropriate point during 
installation of the License Manager software to trigger activation. The certificate is linked to real or 
virtual hardware and is automatically renewed daily. If the Internet connection to the HEIDELBERG 
Trust Service is temporarily down, the existing certificate remains valid for 30 days. Online licensing 
is managed in the Prinect License Manager, while the connection to the HEIDELBERG Trust Center is 
established via the Prinect Maintenance Center.

The License Server and the License Manager interact in a "client-server architecture". Administration 
of the licenses is done in the License Server whereas the License Manager depicts the user interface. 
Normally, the License Server is installed on the Prinect Manager server computer. In bigger system 
environments with a number of Prinect servers and/or Prinect products, it may be advisable to set 
up a dedicated License Server computer. The License Manager user interface can be installed and 
used on multiple client computers simultaneously.

Note: You can find details about licensing in the "HEIDELBERG Prinect Licensing" user 
manual or in the Online Help of the License Manager.

Prinect Maintenance Center

The Prinect Maintenance Center establishes the connection in the print shop to the HEIDELBERG Pri-
nect Software Center (for software downloads), the HEIDELBERG Trust Service (for licensing) and the 
HEIDELBERG customer portal Control Center.

Within the Prinect system environment, the Prinect Maintenance Center is responsible for various 
tasks:

• For Providing he installation files for installing the Prinect software in the print shop,

• for regular checking for available software updates and their provision,

• for controlling update installations taking into account internal dependencies and

• for performing background installations that occur without user intervention.

�

�
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The prerequisite for providing Prinect software components is that the print shop is registered and 
logged in as an organization and with a user account on the HEIDELBERG customer portal. The 
HEIDELBERG customer portal gives you access to the digital services of Heidelberger Druckmaschi-
nen AG.

Sequence Templates

In the Cockpit, the processing operations are configured as "sequence templates" that are to run in 
the output workflow. By selecting certain preconfigured sequence templates, you can prepare and 
output the print jobs in different ways. The option of linking sequence templates lets you run different 
output processes, depending on their setup, more or less automatically.

Basic sequence templates

The following sequence types are required for a Prinect Manager basic workflow: "Qualify" sequence, 
"Prepare" sequence if required and "ImpositionOutput" sequence. Other types of sequences are avail-
able for advanced workflow options.

• The Qualify sequence prepares documents in PostScript or PDF format for processing with the 
Prinect workflow in a "normalization" step. If the PDF format is not suitable for processing with 
the Prinect Manager, these PDF documents can be prepared with the "normalization engine" so 
that further processing can take place in the Prinect workflow ("refrying" process). In principle, 
the input documents must be in a cleaned PDF format that is suitable for the subsequent pro-
cess stages. In a "Preflight" step, the input documents can be checked for the presence of all 
required fonts, the correct image resolution, the use of transparencies, etc. The preflight settings 
can be adapted to the respective requirements.

• After completing the Qualify sequence, the pages can be modified using a "Prepare" sequence. 
This is necessary, for example, if transparency elements contained in multiple layers of a PDF 
document are to be reduced to one layer. The Prepare sequence also offers advanced color man-
agement options.

• There are several proof options offering a preview of the print result to be expected which you 
can use before plate imaging takes place:

· With a "PageProof" sequence, you can output the individual document pages on a page 
proofing device. Page proofs are mainly used to check the correct color reproduction as 
a preview of the final product. For this purpose, the PageProof sequence contains special 
color management settings in which an output color profile adapted to the proofer is 
used. In order to simulate the color effect of the printing material intended for the final 
output, for example, a corresponding simulation profile can also be set for the proof out-
put. If a suitable, calibrated color printer is available in the Prinect configuration, color-
accurate page proofs can be output.
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· With an "ImpositionProof" sequence, you can output sheet layouts on a large-format 
form proofer in order to check the structure of the imposed sheet layouts. If the form 
proofing device is able to produce calibrated color prints, the form proof can also be 
used at the same time to check the color reproduction. For this purpose, the color man-
agement can also be configured in the ImpositionProof sequence to suit the form 
proofer.

• The ImpositionOutput sequence is parameterized for controlling the output of imposed sheets 
for exposing the printing plates (CTP output).

Group Templates

To configure automated processing or to use preconfigured processing sequences repeatedly, you can 
combine several sequence templates into "group templates". In a group template, you can link single 
sequences by drawing connecting lines between them. These kind of linked sequence templates can 
run automatically one after the other without intervention from the user. You can save different pro-
cessing setups as different group templates.

Smart Templates

Smart templates are groups of sequence templates that group all the steps required for automated 
output workflows ("Smart Automation") as is found, for example, in a web-to-print environment. In 
contrast to group templates that are made up of fully setup sequence templates, smart templates 
generally just contain placeholders for the different types of sequences that are linked together in the 
order they will be processed. These placeholders are characterized only by the sequence type and are 
not assigned any parameters when the smart templates are being defined. Only when the job is being 
processed are the required parameters sent to the template placeholders. The processing parameters 
result from the job properties as defined, for example, in the web-to-print application or in the MIS 
(Management Information System).

The smart templates provide, so to speak, a "framework" for the individual work steps of the Prinect 
workflow and for the connections between the work steps. A suitable smart template can be created 
for every possible processing process in a web-to-print environment, e.g. for brochures with saddle 
stitching, for postcards, for calendars, etc. Adapted smart templates can also be created for variants 
that are required due to different format sizes, different substrates or output on different offset or dig-
ital printing presses with the respective finishing options.

When the web shop customer formulates his order, the basic data of the print job such as e.g. the 
product type (brochure, etc.), the format, the scope, the edition, the colors, the type of binding, etc. 
are set. These parameters provide the basis for the selection of a suitable smart template and also 
for the options with which the individual sequences are parameterized.
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Job Processing Workflow

The graphic below shows you a diagram of the basic workflow in processing job files in the PrePress 
workflow:

Files from a customer or from a edito-
rial department

are sent to the print shop as 
PDF files or as PDF/VT files

Page proof

Imposition proof

CTP output

Preparation 
(Qualify, Prepare)

PageProof (with Color Man-
agement)

Imposition
(imported layout)

ImpositionProof

ImpositionOutput
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1. In a first step, the documents to be printed are saved as PDF files in the DTP application. As a 
rule, the customer does this.

2. A new job is created in the Prinect Cockpit when the input files are on hand in the print shop. 
This can be done either directly in the Cockpit user interface or also in the Prinect Portal, in a 
web-to-print application or in the MIS (Management Information System). If you expect a num-
ber of print jobs for a certain customer, you can create a job group where you can group the jobs 
of this customer. Furthermore, it is advisable to enter the customer data (name, contact, etc.) 
into the Prinect customer administration and assign the new job to the customer.

3. A print job opens in the Cockpit after it is created. You can now check its settings and, if neces-
sary, change them. For example, you can modify single sequence templates or configure color 
settings (color order, handling of spot colors, varnishes, etc.).

4. When you create a new print job, you can at this stage assign sequence templates or a group 
template to the job.

5. After that, the document files are added to the job.

6. The job documents are then processed using the sequences assigned to the job. Control print-
outs such as a page or form proof can also be issued.

7. The pages are usually imposed for the form proof or CTP output. To do this, the individual pages 
are assigned to the page placeholders of a page list and/or a predefined layout template. This 
can be done interactively or automatically. The layout templates required for this can be created 
using the Imposition Editor or the Prinect Signa Station software, for example. If the Prinect 
Signa Station software is installed in the local system environment and connected to the Prinect 
Manager, the creation or editing of layout templates can also be started interactively from the 
cockpit. You can obtain information on connecting a Prinect Signa Station with the Prinect 
Manager in the Cockpit help under "Administration – Preferences > Preferences > Local Appli-
cations".

8. After imposition, an imposition proof can be printed if an appropriate proofer is available.

9. When the proofs are found to be OK, CTP output of the imposed sheets can be started with the 
ImpositionOutput sequence.

Note: Color proofers and imposition proofers are set up with the "Prinect Color Proof Pro" 
software and connected to the Prinect Manager. Linearization and calibration of proofers is 
also possible with Color Proof Pro. See also Prinect Color Proof Pro - Online Help.

Platemaking completes the Prepress part of the Prinect workflow. Depending on the configuration of 
the Prinect Manager software, additional options for press output and/or finishing can be used apart 
from the work steps of a basic workflow.

�

�

https://onlinehelp.prinect-lounge.com/Prinect_Color_Proof_Pro/Version2021/en_12/#t=Prinect%2FStart%2FStart.htm
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Set up Users

Prerequisite: Before you set up new users in the Prinect Cockpit, the corresponding user 
accounts must be set up in the Windows system administration of the Prinect Server com-
puter. The future Cockpit users must first be defined with a Windows user account on the 
Prinect Server and be a member of the Windows user group "Prinect Operators". Without 
this setup and configuration as a Windows user, the Prinect users cannot make any changes 
to the settings or to the job data in the Prinect Cockpit. You can find more information in the 
Cockpit Help under "Setting up a new Prinect user".

After installing the Prinect Manager for the first time, you must set up the employees of the print shop 
who are to operate the Prinect Manager as "Prinect users". During the setup, you assign the intended 
roles to the individual users by assigning them to a specific user group and assigning the correspond-
ing access rights. You can access user management in the "Administration" view of the Prinect Cock-
pit under "Users".

Note: If the Prinect Manager has been newly installed, you can log in to the Prinect Cockpit 
with the user name "Administrator" without a password to set up new Cockpit users. We 
recommend deleting the user "Administrator" from the user management after at least one 
company user with administrator permissions is defined.

1. Go to "Administration" and click "Users" (1).

2. The user management opens. Click on the "New" button. The "Create user" dialog opens:

�

�
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Enter the following user data:

· The user name: Enter the user name (in the example, "PeterP"). This user name is used 
as a user account within the Prinect environment – particularly in the Cockpit. At the 
same time, this user account must be defined as a Windows user on the operating sys-
tem of the Prinect server computer (see "Requirements" above). To use the correspond-
ing Windows user account, the "Operating system login password" option must be 
activated. Only if an appropriately configured Windows user account is used for the Pri-
nect user at the same time can the Prinect user access the "PTConfig", "PTJobs" and 
"PTDocs" folders with write permissions when the protection function is activated. With-
out these permissions, the user cannot make any Prinect-specific changes to the settings 
or to the job data in the Prinect Cockpit. Enter a user name here that is defined on the 
Prinect server computer as an appropriately configured Windows user. This (or another 
appropriately configured) user account will be used to log on to the Cockpit in the future.

Note: If you operate the Cockpit on another computer than the Prinect server, e.g. on a Mac 
client, the Prinect user must not be a system user on the client computer, but only on the 
Prinect Server.

· Optionally, you can specify the name of a Windows domain if the Prinect server (and the 
corresponding users) are organized in a domain.

You can find more information about the protection function in the Cockpit Help under 
"Administration > Security".

�

�
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3. In the "Person" area, you can enter additional, personal data about the user (employee number, 
first name, last name). Optionally, you can select a profile picture of the user in the file system 
and assign it to the user.

4. Confirm the dialog with "OK". The new user is now displayed in the "Name" column. Select this 
table entry and assign the user the groups of which he or she should be a member by selecting 
the desired groups in the "Available groups" list and adding them to the "Member of" list by dou-
ble-clicking them or by clicking "Add".

Note: In the vertical tabs "Groups" and "Access Rights" (top left of the window) you can edit 
or redefine user groups and configure the corresponding access rights. You can find more 
information about this in the Cockpit Help under "Administration – Users".

Finish the user configuration by clicking "Save". Click on "Overview" to leave the "Users" administra-
tion area.

Set up Customers

In everyday use of the Prinect Manager workflow, the processed jobs are assigned to the relevant cus-
tomers. For this purpose, the Prinect Manager contains its own customer management. The customer 
information is stored in the master data store and is available at various locations in the Prinect envi-
ronment.

Note: Detailed information on customer management can be found in the Prinect Cockpit 
online help.

In order to be able to assign a customer to the demo jobs used in this documentation, a "virtual cus-
tomer" is set up as an example:

1. Go to "Administration" and click "Customers" (1).

2. Customer administration opens. Click the "New" button. The "Create Customer" dialog opens:

�

�

�

�
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Enter the following customer data:

· Sector: Business

· Name: HD Printshop

· Customer ID: 0001

· Nickname: HDP

3. Click "Open" beside "Person". The "Create Person" dialog opens:
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Enter the following personal details:

· Title: Mr.

· First Name: William

· Family Name: Bauer

· Nickname: WillB

· Language: English

These details about the contact are enough for our purposes. In "Communication Channels", 
you can enter additional data such as phone number and/or mobile number, e-mail address, fax 
number or Web address.

Confirm the "Create Person" dialog with "OK".

Then confirm the "Create Customer" dialog also with "OK".

4. The "Customers" window now displays your new customer at the top left of the customer list (1).
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Mark your customer (1) and fill out the "Address" section (2).

· Street: Hauptstrasse 1

· Postal Code: 10111

· City: Berlin

· Region: Berlin

· Country Code: DE

· Country: Germany

5. Confirm your inputs with "Save". Close the "Customers" window by clicking "Overview".

Create a Job

All the elements involved in the processing of documents are combined to form "jobs". New jobs are 
created in the "Jobs" view using the "New Job" button. You are prompted to enter the following infor-
mation when creating a new job:

• Basic job data

· Job Number
You must assign a job number to each job. A job number generally consists of a number 
of letters and/or digits. The job number identifies each job in the Prinect Manager. For 
that reason, each job must have a unique job number. This is checked when you enter a 
new job number. If the job number you entered already exists, the number displayed is 
colored red and you cannot enter any more data until you enter a job number that is not 
yet used.



Introduction

Prinect Manager – Quick Start Guide 23

· Job Name
The job name is the identifier that is used to display a job in the Cockpit user interface. 
The job name, too, must also be unique in the system. This means that you must give 
each job a job name that is not yet used as a job name in the system. After you enter the 
job number, hit the Tab key. The job number is copied automatically to the "Job Name" 
box. You can use the job number also as the job name or you can edit this entry.

· Documents
This is where you can assign document PDF or image files to the job while you are cre-
ating a job. To do this, click "Browse" and select the relevant files in the file system. You 
can also skip this step and add the document files later after the job is created and 
opened.

· Job Group
Generally, it is advisable to create each job in a job group. This lets you use, for example, 
a separate group for each customer you have. If there is a group structure in the system, 
the group that you selected before you click "New Job" is entered in this box. By clicking 
"Change", you can select a different, available group or create a new group and select it.

· Job Home
In this box, you set the folder in which all the job-specific data will be filed. Normally, the 
job files are filed in the "PTJobs" system folder (e.g. E:\PTJobs) of the Prinect server and 
there in the "Jobs" sub folder. A sub folder with the name of the job group is created 
below the "PTJobs" folder. A folder with the job name is created in this sub folder. All the 
job-specific data are filed in this folder. You must click the lock icon if you do not wish to 
use this default. This releases the linking between job group and job folder and you can 
use "Change" to select another folder for the job files. We recommend that you do this 
only in exceptional cases because the defaults ensure that the job files can be found fast 
in the system. The "PTJobs" folder is shared in the network, meaning that the job files 
can be accessed by other computers in the system environment, for example, by other 
Cockpit computers. In addition, the central location of all job files facilitates a backup of 
the data.

• Customer Data

Assignment of customer data to a job is optional but we strongly recommend that you use the 
Prinect customer administration and assign customer data to each job. See section "Set up 
Customers", page 19. The customer names registered in customer management are available for 
selection in the "Customer name" list box. The "Customer ID" and "Nickname" fields are then 
filled in automatically.

· Customer Job ID
The assigned Prinect job number is entered by default in this box. This is where you can 
enter customer job numbers in the case that your customers use their own job numbers 
that are different to the Prinect job numbers.

· Customer Job Name
Similar to a customer job number, this is where you can enter a different customer job 
name.
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• Processing

In this view, you define the process network with which the job is to be processed. Here, you can 
assign one (or more) sequence templates or one (or more) group templates to the job by clicking 
"Add". With this assignment, you specify how the job is to be processed using the Prinect work-
flow. The work steps defined in the sequence templates can still be edited individually after the 
job has been created. At this point, you can also save the selected sequences as a template for 
automatically generated new jobs (see also chapter "Automatic Creation and Output of Print 
Jobs in the Hotfolder Mode", page 105). You can skip this step at this point and assign the 
required sequence templates later in the open job.

• Scheduling

In this step, you can enter details about the following scheduling data:

· Set Due Date
You can select a date for the scheduled due date by clicking the calendar icon. This date 
is for logging purposes only and does not control the time of printout.

· Responsible
Here you can specify which print shop employee is responsible for processing the job. 
The "Select" button opens a window in which all users set up in the Prinect user man-
agement are available for selection.

· Job Type
You can select one of the following job types from the list box: Production, Product, Pre-
liminary job, CAD (for packaging printing), Reuse, Job Template, Cloud.

· Job Priority
You can assign a priority to each job. For example, this lets you set that very urgent jobs 
are given a higher priority and are processed before other jobs.

· Pages
Generally, the job data or information from the customer tells you how many pages one 
copy of the printed product has. Together with the planned amount (edition), you can 
estimate how big a job will be.

· Delivery Quantity
The delivery quantity indicates how many copies of each printed product will be printed.

After clicking on "Finish", the new job is created and, if the corresponding option is activated, opened 
immediately.

Processing steps and parameters of a Prinect Job

In the Prinect workflow, each print job goes through several processing steps before being printed. 
The properties of a Prinect job can be viewed and configured in different parameter areas in the 
"Jobs" view of the Cockpit. After the job has been set up, it is started and the work steps are carried 
out one after the other.

In detail, a job contains the following parameter areas or work steps:
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• "Product Description" parameter area

Data such as delivery quantity and information about the customer for whom the order was cre-
ated are recorded here.

• "Processing" parameter area

Here, the processing sequences or group sequences are added to the job and displayed in a 
graphic overview. Sequence settings can be edited individually here (by double-clicking on the 
respective sequence symbol).

• "Properties" parameter area

Additional properties such as delivery quantity, planned pages of a job, pre-job information or 
gang job information are recorded here.

• "Colors" parameter area

Here, the type of output of the printing inks defined in the job (color definitions, color sequence, 
usage, etc.) is configured.

• "Printing Process" parameter area

Parameters relevant to the printing process (e.g. the printing order of the pages or the output 
color profile) are displayed or configured here.

• "Documents" processing step

In this step, documents (PDF files or image files) are added to the print job.

• "Pages" processing step

In this step, page lists are defined and the document pages are assigned to the page list place-
holders.

• "Imposition" processing step

In this step, the document pages are assigned to the page placeholders of the sheet layout used.

• "Proof" processing step

In this step, page proofs for color control and/or form proofs for layout control can be carried 
out.

• "Plates" processing step

In this step, the finished sheet layouts are forwarded to the CTP device for exposure.

• "Print" processing step

In the "Print" step you can monitor the printing processes on the offset printing machine.

• "Digital Printing" processing step
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In the "Digital printing" step, the output is controlled on a digital printing machine. The pages 
are imposed interactively and output and finishing options are defined. This step also offers 
options for examining the imposed sheets in detail (magnifying glass function, etc.) and you can, 
for example, see a preview of a finished brochure on the screen, which you can also "flick 
through".

• "History" parameter area

List of actions performed on the job.

"PTConfig", "PTJobs", "PTDocs" and "PTTransfer” Folders

In the Prinect workflow, the "PTConfig", "PTJobs", "PTDocs" and "PTTransfer" folders play a key role. 
These folders are created during installation of the Prinect Manager software on the Prinect server 
computer. Once created, these folders will be shared automatically because they are also used for 
file transfer within the network. By default, the "PTConfig", "PTJobs" and "PTDocs" folders are write-
protected to protect important system files in them from damage. You can check and, if necessary, 
correct these settings in the Cockpit in "Administration > Security". You will find more details about 
this in the Online Help of the Cockpit.

• The "PTConfig" folder contains all the configuration data used in the Prinect Manager. Color 
profile files are also located in the "PTConfig" folder.

• All the data belonging to the jobs created in the Prinect Manager are stored in the "PTJobs" 
folder.

• The "PTDocs" folder is designed for (customer) documents that are to be buffered on the Pri-
nect server before they are added to a Prinect Manager job. Generally, these are PDF docu-
ments, image files, marks and layout templates.

• The "PTTransfer" folder is designed for exchanging or filing files that are to be used in print jobs 
from the system environment of the Prinect server. This folder is not write-protected.

When you launch the Cockpit and log in to the system, you will be automatically connected to the 
"PTJobs", "PTConfig", "PTDocs" and "PTTransfer” folders.

Note: On a Mac Cockpit, this connection will take place automatically, but the folders may 
not be visible on the desktop. If you wish to access data in these folders from the desktop, 
you need to manually mount these folders before you launch the Cockpit. Or, you can 
change the finder preferences on the Mac to show mounted network volumes on the desk-
top.

�

�
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Setup of Presses, CTP Devices and Proofers

To be able to use all required output sequences, you must have set up all the output devices (offset 
presses, digital presses, CTP devices, proofers) on the Prinect Manager. The sequence type "Sheet-
fedPrinting" will not be visible in Cockpit if, for example, no offset press is set up in the system.

You set up output devices in different places of the Prinect Manager, depending on the device type.

• Offset printing presses, color measuring units, non-digital label printing presses, Labelfire digital 
printing presses and digital printing presses that are connected to the Prinect workflow via a 
data terminal, and finishing machines are set up using the device wizard in the "Administration 
> Settings > System" area. Here you can also check whether all required devices are correctly 
registered in the system.

• Other digital printing presses, such as the HEIDELBERG Versafire machines, are set up in the 
"Administration > Digital Presses" area.

• CTP devices are set up during installation of Prinect Renderer.

• You set up proofers with the Color Proof Pro software or, for "softproof" output, in the Proofing 
Engine Manager.

• In addition, Windows system printers (e.g. laser printers) can be connected to the Prinect work-
flow, for example for printing pallet sheets.

Setup of a CTP Device

(HEIDELBERG) CTP devices that are directly connected are set up by installing the interface card of 
the CTP device on the Prinect server computer and installing and setting up the CTP device operating 
software. During the installation, the CTP device signs on to the Prinect Manager and is entered into 
the device list.

If a CTP device is connected to a special CTP shooter workstation (e.g. to a Prinect Shooter 2 work-
station), a "CTP device" of the type "TIFF-B export" is used on the Prinect server. With this setting, the 
Prinect renderer generates the data required for printing plate exposure in the form of TIFF-B files and 
transfers these files to the connected shooter workstation. TIFF-B files contain the complete, raster-
ized information of a printing plate in digital form.

Setup of an Offset Press

Offset printing presses are connected to the Prinect workflow in the Prinect Device Manager using the 
"Central Device Manager (CDM)". To set up an offset printing press, go to the "Administration > Set-
tings" area and click on the folder symbol in front of the "System" entry. The system settings area is 
displayed.
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1. Select the Prinect server in the structure view on the left, click on the folder icon and select the 
entry "CDM".

2. Open the context menu and select "Add Device". The "Device assistant" dialog opens.
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3. Enter a device name and a device ID for the press. These two fields are mandatory. The device 
name can also contain press details such as the number of printing units. Complete the other 
fields as required. You can edit all entries later on except for those in the "Device name" and 
"Device ID" boxes. For more information on how to connect presses, please refer to the Cockpit 
Online Help in the "Connecting Machines" section. Click "Next".
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4. Select the press type in the "Press selection" list box. The appropriate machine-specific data will 
be completed automatically.

Select the control station of the press in the "Control console" list box. You can read the press 
serial number at the control console or directly at your press. This data is required for the auto-
matic import of inking characteristic curves from the press and/or for Analyze Point (assessment 
of color data).

Also select the language and the version of the control console.

The workplace ID is the unique identifier of the printing press workplace in the Prinect Manager. 
You must also specify this ID in the data storage configuration of the control console.

If the press has an Axis Control or Inpress Control option, you can enable the "Enable import of 
color data" option and select a color data folder. Click "Next".
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5. The "Number of printing units" dialog opens. Specify the respective number here — including any 
coating units that may be present. Confirm with "OK". The machine configuration view is 
opened:

6. Radio buttons corresponding to the set number of printing units appear where you can specify 
the type of printing unit in each case. You can also specify for each printing unit whether or not 
a perfector or numbering box is present. You can also delete printing units or add new ones. A 
figure of the configured press displays below the options. When you have added or deleted prin-
ting units, you can click the Refresh button to update the view.

7. The "Custom machine performance values" button opens an additional dialog in which you can 
enter additional set-up times and additional waste sheets. These machine-specific values are 
taken into account, for example, when planning with the Prinect Scheduler. If you enter values 
here, confirm the dialog with "Apply".
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8. After closing the "Custom machine performance values" dialog, click "Next".



Introduction

Prinect Manager – Quick Start Guide 33

9. In the "Assigning operation groups" view you define the operation group (cost type group) avail-
able for production data collection. In an operation group, single operations (shop floor data col-
lection messages) are combined to a group. This gives you a better overview during the subse-
quent manual shop floor data collection (PDC) on the press. You can leave the settings 
unchanged and continue with "Next" if no special assignment is needed.
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10. In the "Assigning operations" view, you assign operations (PDC messages) to the operation 
groups selected beforehand. This assignment is necessary for each of the selected roles (oper-
ator, assistant or multiple operator). Then click "Next".
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11. In the "Assigning user groups" view, you must assign one or several user groups defined in the 
Prinect User Administration to the assigned press operator roles (operator, assistant or multiple 
operator). You must assign the "Operator" at least one user group of the "Operator" type, e.g. 
"PressOperator". You must assign an assistant a user group of the "Assistant" type, e.g. 
"PressAssistant". You must assign a multiple operator a user group of the "MultiUser" type, e.g. 
"PostPressMultiUser". Then click "Next".
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12. The "Create variant" view opens. A variant is understood to mean a press configuration compris-
ing individual modules (such as printing unit, dryer, perfector, coating unit). Depending on the 
device class of the configured press, different modules are available for assembling a variant. 
Define a variant by giving the new variant a name, assigning it a cost center, and selecting the 
existing printing units and assigning them to the press. Then click "Next".
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13. In the "Summary" view, you can once again check if the press was configured correctly. Details 
about the "Pallet sheet" section can be found in the Online Help of the Prinect Cockpit.

14. Click "Finish" to complete the press set-up in Cockpit. The press appears in the tree structure 
below the "CDM" item. You can use the context menu command "Edit" to change the configura-
tion settings of the press at a later date.
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Setting Up a Proofer

You set up proofers for page and/or imposition proof in the Color Proof Pro software. Color Proof Pro 
provides the required drivers and color profiles for supported printers and sends all device informa-
tion automatically to the Prinect Manager.

Prerequisite: To set up a proofer, the device must be ready and either connected to the Pri-
nect server directly (e.g. via USB port) or accessible via the network. In addition, the "Color 
Proof Pro" option must be licensed.

1. To install a new proofer, launch "Color Proof Pro" in the Windows Start menu: Start > Heidelberg 
Prinect Renderer > Color Proof Pro.
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2. Color Proof Pro opens. Open the "Color Proof Pro Settings" category on the start page.

Note: In the "Heidelberg Color Proof Pro Printer Settings" view you can call up the Color 
Proof Pro online help in the "question mark menu".

�

�
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3. Click "Add". Specify a name for the proofer in the "New output device" dialog (description of the 
model). The new printer appears in the "Installed Devices" list box.

4. Select the device type of the connected printer in the "Manufacturer" list box. In "Description" 
you can specify a description of the printer.

5. Go to the "Port" tab.
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6. This is where you define how the proofer is connected to the Color Proof Pro software:

· If the proofer is connected to the Prinect-Server as a Windows system printer, enable the 
"Print to system printer" option (1). Then the printer is available in the list of system print-
ers and must be selected.

· Enable the option "Print via network" (2) if the proofer has a network interface and is 
accessible in the network. In this case, the IP address of the proofer must be known to 
you (ask your system administrator if necessary). Most printers can display their own IP 
address, for example by printing a configuration sheet (accessible in the Settings menu 
of the printer). The "RAW on port" option is enabled automatically. You can leave the 
"9100" entry unchanged in most cases.

Click "Test" when you have specified the IP address. Color Proof Pro will the try to estab-
lish a connection with the specified network address. Use the network address only if the 
test was successful.

· If the printer is controlled via the "LPR (Line Printer) protocol", you must enable the 
"LPR" option and specify the queue name.

· If the printer is connected to the Prinect Server via a local port but is not configured as 
system printer, you must enable the "Print via Port" option and select the appropriate 
port.

Then click "Apply".
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7. Go to the "Profiles" tab. In this tab, you can install output color profiles for the different printing 
materials.

8. Click "Install profiles". The Installer for the proofer profiles starts. This Installer installs the pre-
configured printer profiles included in the shipment. Wait until installation is finished. The 
installed profiles appear in the "Installed Profiles" list. Click "Refresh list" if the new profiles you 
installed do not appear.

Note: For accurate color reproduction, it is essential that you run characterization sepa-
rately for each proofer with the Color Proof Pro software and that you create custom profiles 
for the printing materials used, for example, with the Prinect Color Toolbox. You can assign 
these profiles to the printer with "Import". You will find details about these topics in the 
"Prinect Color Proof Pro – User's Guide” or in the Color Proof Pro Online Help (available in 
the "question mark menu").

Installation of the proofer in Color Proof Pro is now complete. Confirm installation with "OK". 
The "Printer Settings" close, and the start page of Color Proof Pro Engine Manager appears. 
Click "Finish".

9. The newly installed proofer is visible in the Cockpit user interface in the "Administration> Sys-
tem" area under the "Renderer" entry:

�

�
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You can now select the configured proof devices as output device in the respective output sequence 
to generate the desired output in the Prinect workflow.

Create Printing Materials

In Prinect Cockpit, you can store the properties of different printing materials required for offset prin-
ting as data records. You can assign the printing material defined in this way to each of the print jobs. 
This information is suitable for planning or billing purposes.

1. Go to "Administration" and click "Printing Materials and Substrates" in "Resources".
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2. The "Printing Materials and Substrates" view opens. There is a separate tab for printing materi-
als and for substrates (printing materials for digital printing). Click the "Create Printing Material" 
button in the "Printing Materials" tab. The "Create Printing Material" dialog appears. Complete 
the fields as shown the screenshot below:

3. Click "OK". The printing material entry is saved and shown in the list:



Introduction

Prinect Manager – Quick Start Guide 45

As the group name "HD_Printing" was specified for the printing material, it is part of this group. 
You can define any other group of printing materials in this way.

The printing material is saved to the Master Data Store (MDS); this means it is available through-
out the entire Prinect Manager environment and can be used to set up a print job, for example. 
Click "Overview" to return to the Administration master page.

Configure Sequence Templates

To configure the sequence templates needed for the examples below, proceed as follows:

1. Go to "Administration" and click "Templates".

2. The "Templates" view opens. Click the folder icon beside "Sequence Templates" to display the 
single sequence items.
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Configure a Qualify Sequence

1. Highlight the "Qualify" sequence type (1) and click "New" (2).

The setup section for a new Qualify sequence opens:

Set this sequence as follows:

2. Leave "Normalizing", "Split Document", "Automatic Page Assignment" and "Destination" disab-
led or as they are.

3. Enable "Hotfolder" and leave the defaults as they are.

4. Mark the "Preflight" option and display the parameters by clicking the small triangle before the 
check box.

5. Click "Browse" in the "Heidelberg Preflight Profile" section of the "Actions" tab (1). Select the 
"OffsetDefault.hpp" profile.
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6. Click "Save as":
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7. Type in "Qualify_HDCity" as the name and select "HD Printshop" as the customer with "Edit" in 
"Customer ID". Confirm the "Save Template" dialog with "OK".

8. Click "Close". The sequence overview displays.

Configure a PageProof Sequence

1. Highlight the "PageProof" sequence type and click "New".

The setup section for a new PageProof sequence opens:



Introduction

Prinect Manager – Quick Start Guide 49

Set this sequence as follows:

2. Leave "Color Conversion", "Split Document", "Layout Preparation", "Proofing, "Approve Page" 
and "Destination" disabled or as they are.

Edit the following options in the "Imposition" step:

3. Choose "Scale Down to Fit on Media" in the list box "When Media Too Small".

4. Enable the "Color Bar" option and here the "Standard Marks" option, and choose the mark type 
"HD Proof". Also enable the option "Use Colormatching for the Color Bar".

5. Leave all other settings of this step unchanged.

Edit the "Rendering" step as follows:

6. Leave the settings in the "Device" section unchanged.

7. Enable the "Proof Color Management" option and set up parameters as follows:

8. Save the sequence template as "PageProof_HDCity" (with customer assignment) and close the 
window.
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Configure an ImpositionProof Sequence

1. Highlight the "ImpositionProof" sequence type and click "New".

The setup section for a new ImpositionProof sequence opens:

Set this sequence as follows:

2. Leave "Accept approved pages only", "Color Usage", "Color Conversion", "Marks Replacement", 
"Ink Consumption Calculation", "Approve Imposition" and "Destination" as they are.

Edit the following options in the "Imposition" step:

3. Choose "Scale Down to Fit on Media" in the list box "When Media Too Small".

4. Enable the "Color Bar" option and here the "Standard Marks" option, and choose the mark type 
"HD Proof". Also enable the option "Use Colormatching for the Color Bar".

5. Leave all other settings of this step unchanged.

Edit the "Rendering" step as follows:

6. Leave the settings in the "Device" section unchanged.

7. Enable the "Proof Color Management" option and set up parameters as follows:
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8. Leave the settings for the "Proofing" and "Destination" steps unchanged.

9. Save the sequence template as "ImpositionProof_HDCity" (with customer assignment) and close 
the window.

Configure an ImpositionOutput Sequence

1. Highlight the "ImpositionOutput" sequence type and click "New".

The setup section for a new ImpositionOutput sequence opens:

Set this sequence as follows:

2. Leave "Accept approved surfaces only", "Color Usage", "Marks Replacement", "Calibration", 
"Sheet Preview Generation”, "Thumbnail Generation", "Halftone Soft Proof", "File Output", 
"Image Setting", "Plate Approval" and "Destination" disabled or as they are.
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3. Enable "Color Conversion" and set the following options:

4. Set up the parameters in the "Document" tab as follows:

5. Set up the parameters in the "Color Management" tab as follows:

6. Set up the parameters in the "Device Colors/Device Link" tab as follows:

7. Leave the settings in the "Overprint" and "Advanced" tabs unchanged.

8. Select the installed CTP device (in the example Suprasetter_A_105) in the "on" list box of the 
"Imposition" step. This setting will be adopted automatically for all steps using this engine type.

9. Edit the following options here:

10. Choose "Scale Down to Fit on Media" in the "When Media Too Small" list box.

11. Leave all other settings of this step unchanged.

12. Configure the "Rendering" step as follows:
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In this step, you should be especially careful in "Plate" (1) to select a material matching the 
dimensions of the defined sheet layout. In our example, the layout is set up for a 
Speedmaster 52 with a size of 525.0 x 459.0 mm. This is why "SM52" was selected as the mate-
rial name.

Leave the "Printer/ECI offset 2007/ISOcoated_v2_eci.icc" default in the "Press Profile" (2) sec-
tion unchanged. Also leave the options "Use Press Profile from Job Settings, if available" and 
"Use Embedded PDF/X Output Intent, if available, as Press Profile" enabled.

Leave the item "1 glossy coated" selected in "ISO Papertype" (3) of the "Press" section 
unchanged.

13. Configure the "Screening" step as follows:

14. Save the sequence template as "ImpositionOutput_HDCity" (with customer assignment) and 
close the window.

Configure a SheetfedPrinting Sequence

1. Highlight the "SheetfedPrinting" sequence type and click "New".

The setup section for a new SheetfedPrinting sequence opens:
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2. Make sure that in "Printing" the "SM52-8P-3L" press is set in the "on" list box. Leave all other 
options unchanged.

3. Save the sequence template under the name of "SheetfedPrinting_HDCity" (with customer 
assignment) and close the window.

Create a Group Template

For the processing of a job it is not absolutely necessary to create a group template but the use of 
group templates facilitates the processing of further print jobs that need similar processing steps. A 
group template will be created to illustrate how you define and use a group template.

1. Mark "Group Templates" in the sequence overview and click "New".

The empty setup window of a group template opens.
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2. Open the "Qualify" folder and select "Qualify_HDCity" (1). Double-click the item or click "Add 
Template" (2).

An icon for the Qualify sequence is created in the workspace.

3. Repeat step 2 for the "PageProof_HDCity", "ImpositionProof_HDCity", "ImpositionOutput_HDC-
ity", "SheetfedPrinting_HDCity" sequences.

The workspace now displays as follows:

4. In the workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side 
by side and aligned.

5. Now link the "ImpositionOutput_HDCity" and "SheetfedPrinting_HDCity" sequences by clicking 
the sheet icon to the right of the "ImpositionOutput_HDCity" icon and, with the left mouse but-
ton pressed down, drawing a line to the "SheetfedPrinting_HDCity" icon and then letting go of 
the mouse button (drag-and-drop). Connecting both sequences will cause these sequences to be 
automatically executed in succession during job processing.
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We will not add any other links between the other sequence icons because we are not going to 
configure a fully automated workflow here. Both proofing sequences interrupt the final output 
workflow because CTP output and offset printing are only executed after the proof results have 
been assessed.

6. Save the group template with "Save as" as "Group_Template_HDCity" and close the group tem-
plate window.

All the sequence templates needed for a basic workflow are now configured.



Manual Creation of a Print Job

Prinect Manager – Quick Start Guide 57

Manual Creation of a Print Job

Manual Creation of a Print Job ................................................................................................... 57
Storing Job Documents on the Prinect Manager Server ............................................................... 57
Creating a Layout ....................................................................................................................... 59
Licensing PDF Tools ................................................................................................................... 59
Define the Layout .......................................................................................................................60
Creating and Editing a Job Interactively ......................................................................................68
Create a New Job .......................................................................................................................68
Set up a New Job ....................................................................................................................... 73
Preparatory Settings ................................................................................................................... 73
"Documents" Step ...................................................................................................................... 79
"Pages" Step ..............................................................................................................................84
"Imposition" Step .......................................................................................................................88
Print Imposition Proof ................................................................................................................ 92
Start Imaging of Plates ............................................................................................................... 97
Start printing ..............................................................................................................................98
"History", "Files" and "Change Order" sections ..........................................................................100
Close Job .................................................................................................................................. 101
Show several open jobs in tabs ................................................................................................. 102

Manual Creation of a Print Job

In this example we will show you how to process a 36-page booklet "HDCity" with the Prinect Mana-
ger. Later we will show you how new print jobs are created automatically in the "Hotfolder" mode 
(see chapter "Create New Print Jobs by Copying PDF Files to a Hotfolder", page 105).

Note: The examples shown in this documentation solely demonstrate operation and must 
not be understood as imperative instructions.

Storing Job Documents on the Prinect Manager Server

For our sample booklet, we are going to edit and output suitably prepared PDF files as document files 
containing the content pages of "HDCity" in German and English.

1. To open the documents (and sheet layouts) faster later, we will create a new "Testjobs" folder in 
the "PTDocs" folder on the Prinect server (see section "PTConfig", "PTJobs", "PTDocs" and 
"PTTransfer” Folders, page 26).

2. In this folder, create a sub folder named "HDCity-36Pages-A4" and there two sub folders named 
"Layout" and "PDF". The folder structure is now as follows:

�

�
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3. Copy the "HDCity.pdf" to the "PDF" folder.
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Creating a Layout

We are going to use Prinect Imposition Editor to create the sheet layout. The Imposition Editor is part 
of PDF Toolbox that is installed on the Cockpit computer as an Acrobat plug-in during installation of 
the Cockpit.

Note: For more details on the Imposition Editor, please refer to the Online Help of Prinect 
PDF Toolbox. You can invoke Help in Acrobat with the menu item "Plug-Ins > For getting 
help > Plug-in Help > Prinect PDF Toolbox" in the "hamburger menu" in the upper left cor-
ner of the Acrobat window.

Licensing PDF Tools

Before using the Prinect PDF Toolbox applications for the first time, you may have to request a license 
for each of the program modules from Prinect License Server, if this is not set by default during instal-
lation. A floating license for PDF Toolbox comes along with the license key for the Prinect Manager. 
To license the PDF Toolbox, you need the name of the computer on which the License Server is 
installed.

1. Open Acrobat Pro on the Prinect Server and go to "Plug-Ins > Prinect > Licenses".

�

�
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2. In the "License Server" (1) box, type the name of the License Server computer (e.g. the Prinect 
server where the basic Prinect Manager software is installed). The message pane (2) displays a 
confirmation when the License Server has been detected.

3. Mark the items in the list of tools to be licensed (minimum is an "Imposition Editor" license) and 
click "Request". When the appropriate license is found, the licensed item is tagged by a green 
check mark (3). You can also highlight several PDF Toolbox tools at the same time and request 
their licenses.

Define the Layout

Note: The layout we want to create with the Imposition Editor here is to be imported at a 
later stage into the Prinect Manager workflow as an imposition template. The Imposition 
Editor can create importable layouts only if no PDF file is open in Acrobat.

�

�
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1. Open Acrobat Pro on the Prinect Server and select "Plugins > Prinect > Imposition Editor > New 
Layout" (in the "hamburger" menu) — without any document being open.

2. Imposition Editor starts with default settings.
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You must now edit the layout so it matches the conditions of the Prinect workflow.

3. First, set a plate size that matches the press size: In the "Plate Size" list box (1), select "SM52" 
if a Speedmaster 52 press is going to be used for printing, like in our example. You can also 
select another machine if a different type of machine is used or select "User-defined" and match 
the plate size accordingly. Set the plate dimensions as follows:

· Width: 525,000

· Height: 459,000

4. Now set the size of the printing material and select "35x50" in the "Printing Material" list box 
(2):

· Width: 500,000

· Height: 350,000

Leave the "Horizontal center" option enabled.

5. Leave the setting "Center" in the "Folding Sheet Position" list box (3) unchanged.

6. Leave the setting "Turn" in the "Placement Rule" list box (4) unchanged, and also the options 
"AutoApply" and "Front and Back".

7. Enter "36" as the number of pages (5).
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8. Go to the "Marks" tab.

9. Enable all the marks types in the upper area (1): Folding Sheet Cuts, Cut Marks, Fold Marks, and 
Lay Marks Leave the mark details "Offset", "Length" and "Width" unchanged.

Leave the "Ink Pickup Bar" and "Color Bar" options disabled.

Leave the "Register Marks", "Pull Lay" and "Collating Mark" options disabled.

Leave the options "AutoApply" and "Front and Back" enabled.

10. Go to the "Master Pages" tab.
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Leave the settings "From PDF" in the "Page Size" list box, "Width", "Height" and in the "Page Pol-
icies" list box " (= Center) (1) unchanged.

Leave the option "Automatic calculation of Trim Allowance" (2) in the "Trim Allowance for 
Pages" area enabled and specify a value of 3.000 mm for "Bleed" (3).

Leave the options "AutoApply" and "Front and Back" enabled.

11. Go to the "Scheme" tab.
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12. In the "Scheme" (1) area, select the "F4-1 2x1" scheme. In this scheme, two document pages are 
placed on each surface (front and back), arranged in two columns and one row. As the scheme 
loaded in our example contains only two front and two back pages each, the screenshot also 
only displays two pages each per surface.

In the "Master Pages" area (2), leave the "Default" setting as it is.

The graphical preview (3) shows how the pages are arranged. Leave the "Back" option enabled.

Leave the options "AutoApply" and "Front and Back" enabled.

13. Go to the "Layout" tab.



Manual Creation of a Print Job

66 Version 2021.10

Leave the setting "Saddlestitch" in the "Binding Method" list box (1) unchanged.

Specify a creeping value of 2.00 mm. Leave the icon for moving the cut marks (2) unchanged 
(for saddlestitching, the cut marks are moved accordingly).

As our sample configuration does not include a saddlestitcher, you must leave the entry 
"Not existent" in the "Gripper Collator" list box unchanged.

Enable the "AutoArrange Folding Sheets" option in the "Press Sheet Layout" area (3).

Leave the "AutoApply" and "Front and Back" options enabled.

14. The definition of the layout template is now complete. You must now save the layout template.
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Click one of the buttons "Save job" (1) or "Save job as" (2). A dialog opens where you can choose 
the storage location and where you can specify a name for the layout file.
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To quickly identify the layout file in the Prinect workflow, save the layout file as 
"SM52_2x1_36pages.jdf" in the "PTDocs\Testjobs\HDCity-36Pages-A4\Layout" folder of the Pri-
nect server (see section "Storing Job Documents on the Prinect Manager Server", page 57). The 
file name extension ".jdf" is added automatically. Prinect Imposition Editor always saves the job 
files in the "Job Definition Format" with the extension ".jdf". In the Prinect workflow, this file for-
mat is also required for sheet layout files. At the same time, a file named 
"SM52_2x1_36pages_Marks.pdf" is created that contains the marks defined in the layout tem-
plate.

This completes creation of the sheet layout for use in the Prinect Manager. You can now quit Imposi-
tion Editor and Acrobat.

Creating and Editing a Job Interactively

All prerequisites for creating a new job are now being met.

Prerequisite: All the prerequisites required for creating a print job in the Prinect Manager 
are now listed once again below:

· Job content file: HD_City.pdf

· Sheet layout: SM52_2x1_36pages.jdf

· Customer: HD Printshop

· Sequence templates: "Group_Template_HDCity" group template.

Create a New Job

Special characters in job names

Note: The following characters must not be used in job names:

1. In the Prinect Cockpit, go to the "Jobs" view and click "New Job" (1). The "Create new Job" dia-
log opens:

" % ’ * ; < > ? ^ ‘ { | } ~ / \

�

�
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2. This dialog has four views that you can go between with "Next" or "Back". First fill out the boxes 
in the "Basic job data" view:

· Assign a job number. You can take the job number, for example, from the job ticket of a 
customer job. Job numbers must be unique in the Prinect system. This means that each 
job number can be assigned only once. If the "Automatic" option is enabled, a unique job 
number is inserted. In this example, we will assign "HD0001" as the job number.

· Your next step is to assign a job name. Job names as well must be unique. When you go 
to the "Job Name" box, the job number is copied automatically to this box. Heed the 
above note on characters that must not be used in job names! You can use the job num-
ber as a prefix for the job name or overwrite it. We will assign "HD0001_HDCity" as the 
job name.

· In the "Documents" box you can now assign the documents (supplied by the customer) 
to the job. You can also do this step later in the created job. We will not assign any doc-
uments at this point.

· By default, "Job Group" and "Job Home" are linked. This means that if you define a new 
job group, a folder of the same name will be created automatically for this job group. We 
want to create a new job group and click "Change". The "Select Group" dialog opens.
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3. Disable "Start Job" and "Maximize Job View".

4. Click "Next" to open the "Customer Data" view.

Click the plus sign next to the "Job Group" 
input box in the lower part of the window. A 
new input box displays. Enter "MyPrintshop" 
as the group name in this box and confirm 
the dialog with "OK". The "Select Group" 
dialog closes.
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5. Select "HD Printshop" in the "Customer Name" list box. This item is taken from customer admin-
istration of the Prinect Manager. "Customer ID" and "Nickname" are also taken from there. "Cus-
tomer Job ID" and "Customer Job Name" are copied from the basic job data you defined before-
hand. You can overwrite these items if you have other customer job data that differ from the job 
data set in the Prinect Manager. We will leave these items as they are.

6. Click "Next" to open the "Processing" view: In this view, you can add prepared sequence tem-
plates to the job. Click "Add". The "Select Templates to Add" dialog opens:

7. Select "Group_Template_HDCity" and click "OK". The group template contains all the sequence 
templates needed for processing this job. Leave "Save as default" disabled.
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8. Click "Next". The "Scheduling" view opens. In this view, you can enter a due date and assign a 
priority. Leave these settings as they are. Enter "36" in the "Pages" or "1up" box. Enter "5000" 
in the "Delivery quantity" box. These details are for planning only; they do not affect the actual 
processing of the job.

9. All the data needed for creating the new job are now entered. Click "Finish".
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The new job is created and opens in the "Job" window. Double-click the caption bar of the "Job" win-
dow to maximize the width of the window. The view in which a job was last open displays at first. You 
can switch the job view at any time.

Set up a New Job

Preparatory Settings

In the top left corner there is an icon with a small arrow pointing down. This arrow represents a list 
box for toggling between the parameter sections:

• "Product Description"

• "Processing"

• "Properties" 

• "Colors" and

• "Printing Process".

This lets you define preparatory settings for the print job. We are now going to set up the parameters.

Note: If you click the "star" beside one of the icons, the icon also displays in the workflow 
bar to the right of the "Product Description" icon. You remove the icon from the workflow 
bar by clicking the star in the list again.

Product Description

�

�
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1. Select the "Booklet" entry from the "Standard product type" selection list. We leave the "Product 
code" and "Product number " fields under "MIS-specific product type" empty, since in our 
example no MIS is connected to the Prinect workflow.

2. In the "Internal Comments" box, you can type information that can help to later identify the print 
job.

3. Confirm the settings with "Save".

Note: Click the "Notes" button (1) to open the "Notes" view. This view provides an input box 
where you can enter comments about the job. These comments are retained while the job 
exists in the Prinect Manager. The "Notes" view exists in its own right alongside the "Job 
List" and "Job" views and you can close or expand it at any time. You can use the Notes, for 
example, to convey important information about the job to other processing stages (press, 
finishing) to the operators. You will find more details about handling the views in the "Jobs" 
section and about the Notes function in the Online Help of the Cockpit (F1 key).

Processing

In this view, the processing sequences necessary for the job are added and configured. An existing 
group sequence was assigned to the print job when it was created; for this reason, this group 
sequence is shown here. With the "Add Template" button, you can add more sequences or group 
sequences if needed.

As the existing group sequence contains all necessary processing steps, we are going to leave the set-
tings as they are.

�

�
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Properties

In this view, you can define or inspect certain properties of the print job such as Due Date, Priority or 
planned quantities (Delivery quantity, Planned pages). Delivery quantity and planned pages were 
defined when the job was set up. Leave all other settings unchanged.

Colors

In this view you can define how the Prinect Manager is to process the colors of this print job. You can, 
for example import spot color definitions, define new spot colors or determine how certain spot colors 
defined in the original documents are to be mapped to CMYK process colors. If a coating unit is avail-
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able at the press and if the job is intended to be output with varnishing, you can also define a "Var-
nish" color with the "Varnish" entry in the "Target" column. You can find details about these options 
in the Online Help of the Cockpit (invoke with the F1 key).

Note: You can use Prinect PDF Toolbox, for example to find out which spot colors are 
defined in the original PDF files of the print job. To do so, open the PDF files in Acrobat (not 
from within the Prinect Manager workflow) and invoke PDF Toolbox in the Acrobat "ham-
burger menu": "Plugins > Prinect > PDF Toolbox > Color Editor Spot Colors" or "Plugins > 
Prinect > PDF Toolbox > Color Editor Color Management". Use these tools to find informa-
tion about the separations and color definitions in the PDF.

In this step, you will check whether the documents you added have spot colors. To print with CMYK 
process colors only, you must map spot colors to process colors. Normally, the PDF files contain the 
"recipes" for spot color replacement. Below, we will show how you can define or modify a spot color 
replacement in the job settings.

1. Click "New Color".

A new entry is added in the list below the colors.

2. Type "Silver".

Leave the entries in the "Source" (= Job), "Target" (= Output), "Marks" (= Automatic), 
"Type" (= Normal) and "Usage" (= Printing Unit) columns unchanged.

3. If necessary, scroll to the right to edit the other columns, and type the following color values:

C (CYAN): 8, M (MAGENTA): 0, Y (YELLOW): 9, K (BLACK): 19.

4. Leave the other color settings as they are and click "Save".

Printing Process

In this view, you can define to print the print job with a consistent output profile and with a consistent 
process standard.

�

�
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1. Click "Change..." (1) next to the "Output Profile" box. A file selection dialog opens, showing by 
default the "ICC Profiles" in the "SysConfig > Resources" folder on the Prinect server. This folder 
contains the pre-installed ICC profile files of the Prinect server. We recommend saving custom 
ICC profile files here as well so they can be accessed easily.

2. In this context, we need a press output profile and therefore go to the "HDM Offset 2007" sub 
folder of the "Printer" folder. Select the "HDMcoated.icc" profile and confirm with "Select...".
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3. Click "Change..." (2) next to the "Process Standard" box. The "Select Process Standard" dialog 
appears:

4. In the "Process Standard" list box, select "ISO 12647-2_2007 HDM_BB" and "1 (glossy coated)" 
in the "Paper Type (ISO)" box.

5. Confirm the dialog with "Apply".

The "Consistency Check" (1) table shows whether or not the selected parameters "Output Pro-
file" and "Process Standard" comply with each other. A green dot is shown next to each test cri-
terion if everything is OK.

In our example, a warning is displayed for the "Press Profile Color Space" (2) criterion. In the 
pertaining columns, you can see that there is a press profile color space conflict: the expected 
color space (black, cyan, magenta, yellow) differs (seemingly) from the existing color space 
(CYAN, MAGENTA, YELLOW, BLACK). You can ignore this warning because the two entries 
describe the same color space and differ with regard to small/capital letters and the order of the 
color names only.
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6. Save your settings with "Save".

This completes the parameter setup of all preparatory settings.

"Documents" Step

In this step, the document files that will be edited and finally printed are copied to the Prinect work-
flow.

Add documents to the job with the "Add Files" button

To add the document PDF files to the job, you can either drag-and-drop the files from Windows 
Explorer to the window (1) or you can open a file selection dialog with the "Add Files" button (2).

1. Click "Add Files" (2). An appropriate warning appears if the job is not yet started. Confirm the 
dialog and the job starts. The "Add Files" dialog first displays the content of the "PTConfig" folder 
on the Prinect server.

2. Switch to the "PTDocs" folder and then to the "Testjobs" folder, then to the
"HDCity-36Pages-A4" sub folder and then to the "PDF" sub folder.
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3. Highlight the "HD_City.pdf" file and click "OK".

Perhaps, a dialog first displays, asking you whether the file is to be copied or a link created. Click 
"Copy". The job processing is started.
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Add documents using drag-and-drop

As an alternative to the "Add" button, you can also add PDF documents to the "Documents" step by 
dragging-and-dropping them from a Windows Explorer window (or Macintosh Finder window):

1. In addition to the Prinect Cockpit, open the Windows Explorer (or the Macintosh Finder) and go 
to the "PTDocs" folder on the Prinect server. In this folder, go to the "Testjobs" folder, then to the 
"HDCity-36Pages-A4" sub folder and after that to the "PDF" sub folder.

2. Mark "HDCity.pdf", drag it holding down the left mouse button to the "Documents" area in the 
open job or to the "Documents" icon in the process step bar and let go of the mouse button. 
Adding documents using drag-and-drop to the "Documents" step icon in the process step bar 
works even if the step is not open at that moment.

View details about job processing

Because the job was activated before you added the files, the PDF document is processed immedi-
ately by the "Qualify" sequence. When processing is finished, the progress bars may turn yellow, and 
have a "Warning" sign.
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1. You can view the warning details by opening the Preflight Report that was created during pro-
cessing. Mark a document item (2), right-click to display the context-sensitive menu and select 
"Properties". An additional information pane opens on the right:

Note: In the workflow bar, small arrows indicate which step can be done next (1). Depend-
ing on what stage your job is at, several steps may be possible next. A tooltip shows you 
which action is possible in each case.

2. Move the scrollbar (3) fully to the right until you can see the column for the Qualify sequence. 
Click the document icon in this column (4). Acrobat opens with a PDF file containing the Pre-
flight Report:

�

�
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In the report you can see, for example, that the warnings refer to the colors of the document file: 
the maximum dot area is above the permitted threshold of 300%.
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As these messages are warnings only, you can continue processing the document if these warn-
ings do not affect the desired output quality. If this is the case, you ought to recreate the original 
PDF document.

Close the Preflight Report and also the "Properties" view by clicking "Close" (4).

"Pages" Step

Note: If a Prinect Package Designer option – as in the shown example configuration – is 
licensed for your Prinect Manager installation, the term "1ups" is displayed instead of the 
term "Pages".

Go to the "Pages" step.

If the "Properties" area is displayed, close this are by clicking "Close". The list contains only one item 
at first: "Assign Count: Not Assigned" (1). Click the small triangle preceding the item to expand the list 
of all 36 pages contained in the job. Double-clicking a separate page will open the respective docu-
ment in Acrobat where you can, for example, once again check the contents.

Assigning Pages to a Page List

In the Prinect Manager, the document pages must be assigned to a "Page List" before they can be 
output. A page list is a group of "page placeholders", i.e. empty page boxes that are filled with the 
document pages by assigning them. You can assign the pages to a page list as follows:

• by creating a new page list and assigning the pages.

• by assigning the pages to a sheet layout. In the Prinect workflow page lists can be automatically 
created by adding layouts to the job with the "Create new page list" option being activated.

�

�
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Note: If a Prinect Automation Pack is licensed for your Prinect Manager installation, you can 
assign document pages automatically to an existing page list as soon as the document files 
are added to a job. For this to be done, the file names of the PDF documents are composed 
by a predefined pattern and given certain delimiters. When these files are added, the file 
names are interpreted and used for assigning pages or page ranges automatically to page 
list placeholders. This functionality is set up in the "Qualify" sequence in the "Automatic 
Page Assignment" step. You can find more details about this in the Online Help of the Cock-
pit (F1 key).

As the assignment to a sheet layout is not necessary for the page proof (this is done in a later step), 
we are going to create a new page list:

1. Click the "Page Lists" button (1) to go to the "Page Lists" view:

2. Click the "New" button. The "Create Page List" dialog appears:

3. Fill out the dialog as shown (Name: PL_HDCity, Start = 1, Size = 36) and confirm with "OK". The 
new page list appears as a drop-down list.

�

�
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4. Now go to the assignment view by clicking the "Show page list assignment" button (1) and the 
"Show Thumbnails" button (2):

Note: You can also switch to the assignment view by pressing the F9 key on your keyboard, 
i.e. you can toggle between the assignment view and the page list view with the F9 key.

This view shows the document pages to the left, and the (initially empty) page placeholders of 
the page list to the right.

5. In principle, you could now assign each separate page to a page list placeholder with drag & 
drop. You can apply this method if you need a page sequence in the page list differing from the 
sequence in the original documents. In our example, we want to accept the original sequence 
for the page list. For this reason we will select all original pages by group selection (click any 
page and press Ctrl + a) and drag-and-drop the selection to the page list placeholders.

�

�
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6. All pages are assigned in the original sequence of the page list now:

Page output

At this point, you can print the assigned pages to the connected page proofer to check the color set-
tings.

1. In the page list (right pane), select the page(s) to be printed to the color proofer (multiple selec-
tion is possible). You can select all assigned pages by clicking any page and pressing Ctrl + a.

The proof output (like any other output as well) is triggered in the Prinect workflow by appropri-
ate elements (in this case the document pages) being submitted to an output sequence (in this 
case the "PageProof" sequence). The appropriate output device is configured in the output 
sequence, in this case a color proofer.

2. Holding down the left mouse button, drag the marked pages to the "PageProof_HDCity" item in 
the "Submit to" group.
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Alternatively, you can also click the "Submit" button (only available in the pages view (1)) or hit 
the F12 key on the keyboard.

3. The proof output starts. To check the progress of the output, switch back to the "Pages" view (1), 
expand the page list and move the image section until the "Status" column is visible.

"Imposition" Step

In our example, a layout was created with Prinect Imposition Editor (see section "Creating a Layout", 
page 59).

Add a Layout

To add a layout to the job, proceed as follows:

1. Go to the "Imposition" step and click "Import" (1).

Note: You can also drag-and-drop layout files from a Windows Explorer window (or Mac 
Finder window) to the "Imposition" step, either by dragging them to the layout window or to 
the "Imposition" icon (see also "Add documents using drag-and-drop", page 81).

The "Select Layout" dialog opens:

�
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2. In the "Look in" list box, go to the "PTDocs" folder of the Prinect server. In this folder, go to the 
"Testjobs" folder, then to the "HDCity-36Pages-A4" sub folder and after that to the "Layout" sub 
folder. Select the "SM52_2x1_36pages.jdf" layout file. You can view details about the layout set-
tings in the "Select Layout" dialog. It also indicates whether or not the layout is valid. This infor-
mation is important because an invalid layout cannot be used in the Prinect Manager. Confirm 
the dialog with "OK".

The "Import Layout" dialog opens.
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3. Because we had already created a "PL_HDCity" page list and this page list matches the layout, 
we can use this page list. For that reason, we will leave the "Create New Page List" option dis-
abled. We recommend enabling this option if you do not have a page list so far. We will leave the 
other settings as they are and click "Import".

4. A warning could appear before the layout is imported:
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This warning informs you that the paper data of at least one sheet is incomplete. Click "OK" to 
import the layout in spite of the warning. Next, a note appears that recommends running the 
Planning Assistant. Wishing to work without the Planning Assistant in our example, we answer 
"No" in this dialog.

The layout is then shown in a list view. In the "Page Lists" column, you can see that the pages 
are already assigned to the "PL_HDCity" page list.

Assigning Pages to the Layout

1. Normally, the single pages must now be assigned to the page placeholders of the layout. You 
assign them as described in the section "Assigning Pages to a Page List", page 84. But because 
the pages are already assigned to the "PL_HDCity" page list and because you want to keep the 
order and number of pages, you do not have to reassign the pages. To check your assigned data, 
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click the "Layout Assignment View" button (1) to view the assigned data. Now expand each of 
the elements in the right window section and click the "Show Thumbnails" button (2) to view the 
page assignment.

2. If necessary, you can also assign the pages separately to the various placeholders and, by doing 
so, define the page order in the layout as you wish.

You can then check the imposed sheets with an imposition proof.

Print Imposition Proof

Basically, you have the following options for starting output of an imposition proof:

• In the "Imposition" step: Submit with drag-and-drop, page 92

• In the "Proof" step: Submit with "Submit" button, page 93

• In the "Proof" step: Submit with drag-and-drop, page 95

In the "Imposition" step: Submit with drag-and-drop

1. Mark the relevant layouts and, with the left mouse button held down, drag the mouse cursor to 
the icon of the "Proof" step in the process steps bar. A list of all sequences available in the 
"Proof" step displays below the icon, in our example, the "ImpositionProof_HDCity" sequence.

2. When you position the mouse cursor on this item and let go of the mouse button, the selected 
layouts are submitted directly to this sequence.

Note: You can add a new sequence template to the "Proof" step if you keep the "Ctrl" key 
pressed down while you are dragging the documents. The selected layouts are processed 
automatically by the new sequence.

�

�
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In the "Proof" step: Submit with "Submit" button

1. Go to the "Proof" step by clicking that icon. To check or to continue editing, you can use various 
views:

The sheets are shown in a list view first. You can inspect the layouts, the sheets, and the front 
and back by expanding each of the items in the list.

+

Click "Separations" (1) to go to the separations view.
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In this view, you can check the separations contained in the documents. Click the button "Lay-
outs" (2) to go back to the layout view:

Click "Show Thumbnails" (3) to show the surfaces as thumbnails. Click "Show List" (4) to go 
back to the list view.

2. Mark the whole end product, a single layout or a sheet and click "Submit". The "Submit" dialog 
opens. The "ImpositionProof_HDCity" sequence is set by default.
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Confirm the dialog with "OK". Proofing starts.

In the "Proof" step: Submit with drag-and-drop

1. Switch to the list view, if necessary (1):
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2. Mark the layout, a sheet or a surface (front or back). As we want to output the entire booklet to 
the form proofer, we will select the "SM52_2x1_36pages" layout and drag-and-drop it onto the 
"ImpositionProof_HDCity" sequence. In our example, a warning displays. In this case, we ignore 
the warning and confirm the dialog with "Continue" each time.

Output starts. A progress bar indicates the processing status.

When output is complete, you can check the result on the printed proofs.

Sheet preview in Acrobat

You can also open the imposed sheet layouts as a preview in Acrobat. To do this, go to the Layouts 
view, mark a layout item in the list and select "Layout Preview" in the context-sensitive menu:

The Prinect Imposition Editor opens as "Layout Preview" in a separate Acrobat window showing the 
sheet layout:
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Go to the "Plates" step if the result of the imposition proof is OK.

Start Imaging of Plates

The "Show Layouts", "Show layout assignment", "Show List" and "Show Thumbnails" buttons are 
also available in the "Imposition" step. See also section "Print Imposition Proof", page 92

You can also open the Layout Preview. See also section "Sheet preview in Acrobat", page 96.
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To start CTP output, expand the "End product" item and drag-and-drop "SM52_2x1_36pages" (1) onto 
the "ImpositionOutput_HDCity" sequence. You can also click "Submit" and select the 
"ImpositionOutput_HDCity" sequence. CTP output starts.

After successful imaging, all printing plate items are given the status "Completed".

Start printing

When platemaking is finished, go to the "Print" step. The "SheetfedPrinting" sequence starts auto-
matically because we linked the "ImpositionOutput" and "SheetfedPrinting" sequences beforehand in 
the group sequence template used. In the print shop, the imaged plates must be loaded to the press 
and printing started on the press.



Manual Creation of a Print Job

Prinect Manager – Quick Start Guide 99

In the "Print" step, you can toggle between the "Print" (1) and "Operations" (2) views. This step is 
mainly used to check the press settings you can make in Prinect Cockpit.

In the "Press" view (1), you can click the "Properties" button (2) to view details about the press job 
properties:

In the left window section, you can select the entire layout or individual separations. Depending on 
your selection, the right window section shows information regarding the selected item. You can find 
details about these items in the Online Help of the Cockpit (F1 key). Click "Close" to close the Proper-
ties view again.
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Click the "Operations" button (1) to go to the Operations view. Each of the press operations is shown 
here. A "real" feedback of the operations from the press is possible only if the press is connected to 
the Prinect Manager server, e.g. with a PressCenter Station.

"History", "Files" and "Change Order" sections

Printing on the press completes the processing of the job in Prinect Cockpit. In the top right corner 
of the Job window, there is an icon with a small arrow pointing downwards. You can switch between 
the "History", "Files" and "Change Order" sections by clicking this arrow.

"History" section

The "History" view lists all internal processing steps performed on the open print job. Here you can 
review all job processing steps. The "Files" and "Change Order" icons also display when you click the 
small arrow in the "History" icon. Click the icon you want to go to that view.

Note: If you click the "star" beside one of the icons, the icon also displays in the workflow 
bar to the right of the "History" icon. You remove the icon from the workflow bar by clicking 
the star in the list again.

�

�
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"Files" view

The "Files" view lists all files and folders relevant for the print job. You can for example easily see here 
where any of the files is stored in the file system.

"Change Order" view

This view is designed for the case that a Management Information System (MIS), e.g. a Prinect Busi-
ness Manager, is connected to the Prinect Manager. Order changes are usually done in the MIS. 
Details about such order changes display in this view.

Close Job

You can close the job (button "Close Job") when processing is finished. The finished job now displays 
in the job list., but is not selected. The job opens automatically in the "Job" window when you click 
it in the job list.
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The jobs last opened are displayed by icons in the "Job" view. You open a job by clicking the job icon 
concerned.

Show several open jobs in tabs

Open jobs display in tabs, with the job number as the tab label (1), (2), (3). If a job is already open 
and you go to another job, e.g. by clicking a different job in the job list, the open job closes and the 
new job opens in the same tab. Click the plus sign to the right of the tabs (4) to open several jobs at 
the same time. If you want to open several jobs at the same time, click on the plus sign to the right 
of the tabs (4).

Each open job displays in its own tab, with the job number as the tab label (1), (3). Click the plus sign 
to the right of the tabs (4) if you wish to open another job in a new tab without closing another job.
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The recently open jobs first display as icons in the new, empty tab. Click a job icon or click an item 
in the job list (the empty tab must be marked) to open the related job in this tab.

Note: Short cut: The job opens in a new tab if you click a job in the job list while holding 
down the Alt key.

This lets you open several jobs at the same time. You can quickly switch to a tab you want by clicking 
the tab header.

A double-arrow icon displays if too many tabs are open for all headers to display in the job window.

When you click this icon, a menu displays, showing all the open job tabs. This is where you can select 
the tab that will be shown.

The "Close Job" button and the "X" icon on the tab have the same function: the job and the related 
tab close. Exception: When you close the last open job tab, a new tab with the Find Job function then 
displays.

Note: When you close a job or a tab with an open job and open this job again at a later point 
in time, the job opens in the state it had when it was closed.

�
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Create New Print Jobs by Copying PDF Files to a 
Hotfolder

With the Prinect Manager you can set up a print job in such a way that new print jobs are automati-
cally created when documents are filed in a folder that is set up as a "hotfolder". In this chapter we 
will set up such a print job and describe how to create new jobs.

Prepare a Print Job

Prerequisite: The following requirements must be met for output with a reusable print job:

· A Qualify sequence with an enabled and setup Hotfolder option must be available.

· A special Hotfolder print job template must be set up in "Administration > Hotfolder".

· A sheet layout matching the planned output format must be available.

· The documents to be output must be able to be edited without an error and their page 
size must match the sheet layout. The number of pages does not have to match the page 
total defined originally in the sheet layout. It will be matched automatically during out-
put.

We will use the "HDCity" booklet print job as our basis, like in the chapter "Manual Creation of a Print 
Job", page 57.

Set up a Qualify sequence for the hotfolder mode

Go to the "Administration >Templates" view.
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1. Open the "Qualify" sequence type, highlight "Qualify_HDCity" and click "Open". We will modify 
this configured Qualify sequence for automated job creation and save it as a new template with 
a different name.

The setup section for the "Qualify_HDCity" sequence opens:

Set this sequence as follows:

2. Except for "Hotfolder" leave all other options as they are.

3. Enable "Hotfolder" and set the following parameters:
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a. In the "Hotfolder" box (1) leave the "$Template" setting as it is. This setting makes sure 
that the file names of the job documents are used for the names of the new jobs.

Note: In the "Hotfolder" box, it is also possible for you to set an "External hotfolder location" 
instead of "$Template". To be able to do this, a hotfolder location must have been set in the 
system settings (Administration > System). This folder must be shared. You will find more 
details about this in the Online Help of the Cockpit.

b. Enable the "in...Job Location" option (2). Use this option to file the new jobs below the 
"PTJobs" folder (if "$Template" is set) or in the set hotfolder location on the Prinect 
server.

c. Enable "Create new job and process document there" (3). When this option is enabled, 
new jobs are created automatically when document files are stored in the hotfolder.

Using the settings below, you define how the file name of the PDF documents will be 
interpreted to create new print jobs automatically. To this end, you must change the PDF 
file names in such a way that various components in the file name are separated by 
delimiters and are used for job parameters. This is where you define the rules by which 
the file names will be interpreted. You can find more details about the detection rules in 
the Cockpit Online Help.

d. Select "the job number" in the "at position 1" list box (4). This defines that the first com-
ponent of the PDF document name will be interpreted as the job number.

e. Enable "from first character" in the first row. As a result, all characters in the file name 
up to the first delimiter are interpreted as the job number.

f. Enter the character "#" into the "up to delimiter" box (5). As a result, the file name of the 
filed documents is interpreted in such as way that all characters before the "#" in the file 
name are interpreted as a job number and are used for the new jobs. The file names of 
the filed documents must have this delimiter and appropriate characters for the job num-
ber in order for new jobs to have a job number.

g. Select "the job name" in the "at position 2" list box (6). This defines that the second com-
ponent of the file name (after the first delimiter) will be interpreted as the job name.

h. Leave "from first character" in this row disabled.

i. Enter the character "&" into the "up to delimiter" box (7). This character acts as a rear 
limitation for the job name. All the characters between the two delimiters "#" and "&" in 
the file name of the stored documents are used as the job name.

�

�
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Example: A document named "1234#Brochure_HD&.pdf" creates a job with the number 
"1234" and job name "Brochure_HD".

j. In the "Job group for new job" list box (8) leave "Current job group" set. The new jobs 
generated are created in the same job group as the original job.

Caution: Make sure that job numbers in a Prinect Manager environment are always unique. 
A new job may overwrite an existing job if the new job is created in the hotfolder mode and 
its job number matches that of the existing job! Use the settings below to prevent existing 
jobs from being overwritten.

k. Set "Create and use job with a new job number" in the "When job number already exists" 
list box (9). If the job number determined from the PDF file name already exists, a new 
job number is created by appending an index. The new job created is given this job num-
ber.

l. In the "Keep existing process network" list box (10) or using "Generate a new process 
network via Smart Automation if a product code is detected", you can define whether a 
new process network will be created for each automatically generated job or whether the 
process network of the template job will be used for the new jobs. A process network is 
a combination of print jobs, sheets or sheet layouts and sheet-processing sequences.

In our example, we will use the process network of the template job and, for that reason, 
select "Keep existing process network".

4. Leave the other steps as they are and click "Save as".
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5. Assign "Qualify_AutoJob" as the name and, if not already set, select "HD Printshop" as the cus-
tomer using "Select Customer". Confirm the "Save Template" dialog with "OK".

Note: The "Product Codes" and "Product Types" parameters are designed for an automated 
workflow ("Smart Automation") with a connected Web shop and/or an MIS. Based on these 
parameters, sequences matching certain products will be used for production in an auto-
mated workflow. No data was entered in these boxes in our example.

6. Click "Close". The sequence overview displays:

�
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Note: If required, you can set up a "Prepare" sequence template and use it in the workflow. 
This may be necessary, for example, if you wish to use the detailed settings of HEIDELBERG 
Color Management or if you have to reduce transparency elements in the job documents. 
You can find details about the various parameters of the sequences in the Online Help of 
the Cockpit (F1 key).

Edit a group template for automatic job creation

A group template containing the "Qualify_AutoJob" Qualify sequence is to be used for the new print 
jobs created. To this end, we will use the "Group_Template_HDCity" group template set up before-
hand (see "Create a Group Template", page 54) and swap the Qualify sequence within this group 
template.

1. Go to "Administration > Templates" and open the "Group_Template_HDCity" group template.

2. Highlight the "Qualify_HDCity" sequence (1) and click "Delete" (2).

�
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3. Add the "Qualify_AutoJob" Qualify sequence.

4. Leave the other sequences as they are and save the group template as "Group_Template_Auto-
Job" and close it.

Automatic creation of print jobs

After the Qualify sequence is set up, a hotfolder job template is now created. An "external hotfolder 
location" must be defined for this. A Qualify sequence with an enabled hotfolder option is also 
required.

Define an external hotfolder location

To create hotfolder job templates, it is imperative that an "external hotfolder location" is defined. Pro-
ceed as follows to create an external hotfolder location:

1. Go to "Administration > System" and mark "System".
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2. Click "Add Job Folder" in the "External Hotfolders Location" section.

3. Go to the "PTTransfer" folder and click "Create new folder" icon (1).

4. Name the folder "External_HF".

5. Confirm with “OK” and click "Open".
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6. The external hotfolder location is defined. The green dot indicates that this folder is available as 
an external hotfolder location. Confirm the change with "Save" and click "Overview".

Create a hotfolder job template

1. Go to "Administration" or click "Overview" if the administration options do not display.

2. Click the "Hotfolder" icon. The "Hotfolder" section displays:
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This is where you define the job templates that are intended solely for the automatic creation of 
new jobs. These job templates do not display in "Jobs" so that they are not inadvertently 
deleted.

3. Click "New". Input boxes now display on the right. Type in the following data:

• Name: Auto-HF01

• Job group for new job: with current date

• Processing: Add the "Group_Template_HDCity" with "Import".

4. Confirm your settings with "Save".

5. The hotfolder template is set up. Click "Overview".
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Create a New Job by Filing to the Hotfolder

After you prepared the job template for automatic job creation in the hotfolder mode, automatic cre-
ation of new jobs and their processing can begin.

Prepare Document File Names

Delimiters were defined in the hotfolder settings of the Qualify sequence and they can be used to filter 
out the job number and job name from the document file names. We will customize the file names of 
the PDF documents to be output so that we have useful job numbers and job names.

We will use the "HDCity.PDF" document again as the example document. We will now duplicate this 
file (with Copy and Paste) and rename it to "AJ0001#HDCity_A4&P01_P36.pdf" to meet the require-
ments for automatic job creation. Based on the set delimiters "#" and "&", a new job with job number 
"AJ0001", the job name "HDCity_A4" and a page range 1 – 36 pages will be produced.

Create and Start a Print Job Automatically

Proceed as follows:

1. Open a Windows Explorer window and go to the folder where the "HDCity.PDF" file is located (in 
the example, in the "PTDocs\Testjobs\HDCity-36Pages-A4\PDF" folder).

2. Duplicate the "HDCity.PDF" file and rename it to "AJ0001#HDCity_A4&P01_P36.pdf".

3. Open a second Explorer window and position both windows so that you can see both of them 
fully on the screen.

4. In the second Explorer window, go to the "\\PTTransfer\External_HF\Auto-HF01" folder. This 
folder was created by the system when you were creating the hotfolder job template. See 
"Create a hotfolder job template", page 113.

5. In the first Explorer window, mark "AJ0001#HDCity_A4&P01_P36.pdf" and, holding down the left 
mouse button, move the mouse pointer to the second Explorer window, to the 
"\\PTTransfer\External_HF\Auto-HF01" folder in the example. Let go of the mouse button at this 
point. The file is moved. To copy it, press the "Ctrl" key at the same time while you are moving 
the mouse cursor.

6. Go to the Cockpit again. After a while, a new job group with the date the job was created (1) and 
in it a new job "HDCity_A4" (2) with job number "AJ0001" (3) displays in the job list.
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The job is started automatically.

7. Click the job in the job list, go to the "Job" window, maximize the width of the window by dou-
ble-clicking the caption bar and go to "Processing". In this section, add other sequences as 
described in section "Preparatory Settings", page 73.

8. Continue with the following processing steps:

· "Documents" Step, page 79

· "Pages" Step, page 84

· "Imposition" Step, page 88

· Print Imposition Proof, page 92

· Start Imaging of Plates, page 97

· Start printing, page 98

9. When finished, close the job.

In this way, you can automatically generate more print jobs.
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Grouping the Job List
The grouping of the job list can be adjusted by 

dragging & dropping the columns.

Filters
Show/Hide filter area

Predefined Filters:

• All Jobs

• 	Active

•	Finished
Self-defined filters

Filter Settings
In this field, individual filters which then are 

available as “self-defined filters”, can be created 

by the user.

Recycle Bin
If this icon is clicked, jobs which were moved 

into the recycle bin are displayed in the job 

list. These jobs can be deleted definitely, or be 

restored.

Job List - Functionality and Icons.
Prinect Cockpit.

New job

Suspended

Modified

Idle

Processing

Canceled

Finished

Waiting

Job States

Jobs

Queues

Administration

Digital Printing Terminal

Portal Services

Job Combiner

Analyze Point

Scheduler

Cockpit - Workspaces*

Adaption required

Part of gang job

Planned for gang job

Gang job

Job is imported

Job is exported

Change order by MIS 

Adaption required

Locked

Locked by user

Intervention required

Approval required

Archived

Restored from archive

Cleared up 

Migration required

Offline

Online

Job Flags*

Corresponding job

With parameters

With parameters, wit-
hout machine data

IdleReset into the initial state

Here characters can be 

entered for which the job list is 

searched.

The following fields are 

searched: 

- Job name

- Job number

- Customer name

- Short name

- Customer number

- Customer job number

- Customer job name

Search

Notes can be generated for each job. In the “Job Notes” column the 

availability of notes is indicated.

If the window is minimized as shown here, it can be restored by 

double-clicking the “bar”.

“Job Notes” Window (minimized)

Workflow States*

CAD

Documents

Pages/1ups

Imposition

Proof

Plates

Precutting

Printing

Digital Printing

Sheet Processing

Product

Self-defined

Workflow steps available in the job are displayed in color.

     by user,      by system flagged as “ready”.

Product finishing steps are finished

CAD Design by Package Designer 
is available

Documents have passed the qualify 
sequence

Pages/1ups have passed the 
prepare sequence

Layout is created/imported and 
pages are assigned

Form proofs are available

Plates are created

Precutting is finished

Printing is finished

Digital printing is finished

Cutting and folding steps are 
finished

Bottom Line
In the bottom line, information on the status of 

the Prinect Manager is displayed.

Heidelberger Druckmaschinen AG
Kurfürsten-Anlage 52 - 60 69115 Heidelberg Germany
Phone +49 6221 92-00 heidelberg.com

* License-dependent

Drag & Drop of Files
PDF files can be added to a job by dragging 

& dropping on the respective job. If PDF files 

are dragged on a folder or on a template job, a 

new job is created.

Columns
The       button is used for re-sorting and show-

ing/hiding columns. The order can also be defi-

ned by drag & drop. The settings can be saved as 

a scheme.

After double-clicking on a job in the job list, the job is opened in the 

maximized “Job” window. If the window is minimized, as shown here, it 

can be opened by double-clicking the “bar”.

If the “Job List” and the “Job” windows are opened simultaneously, the 

job displayed in the “Job” window can be changed by single-clicking on 

another job in the job list.

“Job” Window (minimized)

Job List

Job

Job Notes

Minimize width

Maximize width

Fix width (Job Notes and Digital Printing 
Terminal only)

Window Captions

If a window is mini-

mized, it can be res-

tored by clicking the 

corresponding icon.

Systemnachrichten

MeineDaten.pdf

Background Processes
Clicking on the icon 

opens the 

“Background Processes” 

window.

Detach window (Jobs, Job Notes and 

Digital Printing Terminal only

Digital Printing
Terminal (minimized)
Gives an overview of the status of 

the digital printing jobs.

Clicking on this icon 

           opens the “System 

messages” window.

System Messages

filters the following job states:

Setup (changed, new job)

Active (idle, suspended, processing,

waiting)



Open Job - Functionality and Icons.
Prinect Cockpit.
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Views

Pages

Page lists

Assign pages to page lists

Layouts

Place pages on a layout

Color separations

Operations

Workflow Steps*

CAD - Connection to the Package Designer  

Documents     
Add documents to the job

Pages/1ups - Page/1up preparation 

Imposition 

Proof 
Page and/or form proof output

Plates - Plate recording

Precutting

Digital Printing

Press - Printing press output

Sheet Processing

Product - Finishing

1 Counter

1ups

Documents

Pages/1ups

Sheets

Sheets

Plates

Press runs

Folding sheets

Submit Elements to another Workflow Step

Submit elements to another workflow step by 

drag & drop: if selected elements are dragged 

on a suitable workflow icon, the sequences 

which are available in that step and which are 

able to process the elements, are displayed. 

A sequence can be selected in the drop-down 

list for submitting. If the elements are dragged 

just on the icon, the “Submit Elements” dialog 

is opened. If simultaneously the Ctrl key is pressed, an arbitrary sequence template can be 

added to the job.

Workflow Bar*

If there is not enough space to show all workflow icons, the icon bar can be 

shifted to the left or to the right by clicking on the triangles, or via mouse-

move.

Counter displays the number of 

elements (pages, layouts, etc.) inside 

a workflow step.

Progress: 

Progress in %

System reports step as 

“ready“

The step is flagged as 

“finally finished” by the user

The “active” step 
is displayed in 
light gray

A      indicates that this workflow step requires 

user intervention. A tooltip on this icon gives 

more information.

Right Parameter Area

History - Information on the history of the single processes 

during job processing

Files - Displays the folders in the file system which are 

involved in the job processing

Change order - Displays the change orders being registered 

for the job

Portal Services - Configuration of the Portal Services view 

for this job and the E-mail management

Group approval - Configuration of the group approval

Status Area

Here the processing 

steps progress of the 

current job is displayed.

Incorporate icons from the list box into the head line 

Right in addition to the parameter icons is a “star” icon. By 

clicking on it, the corresponding parameter icon is displayed 

also in the head line right from the workflow bar.

Simultaneously the “star” icon is colored yellow.

A repeated clicking on the “star” icon removes the parame-

ter icon from the head line.

Left Parameter Area

Product description - 

comments, customer data, 

product code 

Processing - configuration of the 

sequences used in the job

Properties - due date, job priority, 

delivery quantity, related job, gang 

job data

Colors - Color definitions, order of 

the colors, spot colors

Printing process - printing profi-

les, print order, paper classes

A       indicates if user intervention 

is required.

Incorporate icons from the list 

box into the head line 

Right in addition to the parameter 

icons is a “star” icon. By clicking 

on it, the corresponding parameter 

icon is displayed also in the head 

line left from the workflow bar.

Simultaneously the “star” icon is 

colored yellow. A repeated clicking 

on the “star” icon removes the 

parameter icon from the head line.

“Job” Window
Here the elements (job 

content, control elements) 

of the selected workflow 

step (in this example Digital 

Printing) are available.

Notes can be generated for every job. The 

notes survive to every job as long as the 

job exists in Prinect Manager.

“Job Notes” Window

Changing the Width of the Win-

dows
If the mouse cursor is positioned exactly 

between two windows, it will look like a double-

arrow. Now the width of the window can be 

adjusted if the mouse button is held fixed.

“Job List” Window
After clicking on a job 

in the job list, this job 

is opened in the “Job” 

window.

System Messages
Clicking on this icon opens       

          the “System 

messages” window

The “next step” arrow 
indicates what is the next 
step to proceed in the 
workflow. A tooltip will tell 
you what is the next action.

News

Here is notified, 

if and how 

many nes are 

available.

Gives an overview of the 

status of the digital printing 

jobs.

Digital Printing
Terminal (minimized)

Due Date indicates the 
status of the workflow step’s 
due date.

Scheduling
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